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Welcome

Thank you for choosing the PCC Print Center!  
We welcome any project from students, faculty, 
staff, and community members. No project is too 
big or too small. Whether it’s a small printing project, 
digital or web campaign, marketing strategy, design 
assistance, or all-of-the-above, we’re here to help.

To aid you in creating and ordering a successful 
end product, we’ve created this resource guide 
with common printing terms, design set-up tips/
resources, and various other information. 

You can also find more detailed information at our  
Print Center resources page: pcc.edu/print.

As always, our friendly team is happy to answer your 
questions and guide you to the best process and end 
product(s) to make your project a success. 

Please contact us for assistance at:

PCC Print Center

Sylvania Campus, CC 116  
(accessible from outside entrance only)

pcc.edu/print-center
971.722.4670
printcen@pcc.edu

Open Monday - Friday from 7am - 4pm
Closed Weekends and PCC-recognized holidays
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1Project Planning Checklist 
There are many factors to consider before designing and printing 
your project. To save you time, effort, and money, we’ve created 
this checklist and timeline to help you reach your goals on time 
and within budget.

Type of Project:	 Event	 Publication

Event - Needed Information:

Title:	

Time/date:	

Location:	

Event details:	

	

ADA requirements and sponsor icons

Printing needs:	

Budget for printing:	  

Flyers: (Total Quantity)	 Size:	

Posters: (Total Quantity)	 Size:	

Handbills: (Total Quantity)	 Size:	

Web banner/email: 	 Size:	

Other:	 Size:	

Publication - Needed Information:

Title:	

Time/date needed:	

Budget for printing:	

What do you want the finished product to be?:	

	

	

Printing needs:	

Proof-check by:(date)	

Ink type:(black/white or color)	

Binding:	

Trimming:	

Other:	



Project Timeline

Printing Budget

Important Details

•	Event title

•	Event date

•	Event location

•	Call to action

•	Audience

Production Research

•	Types of print

•	Where will the finished 
product be posted?

•	Price quotes

•	Asset gathering

Proofing Deadlines

•	Design time

•	Proof reading

•	Stakeholder approval

•	Prepare for  
print/publication

Production Deadlines

•	Send to print

•	Press check/proof approval

•	Production

•	Delivery

Planning

Start

Deadlines

Creation

Print/Production



Posting/Distribution

•	 Recommended:  
2 weeks before event

Host Event or 
Distribute Project

Success/Issues

•	 How many attended 
your event or how well 
received was the finished 
project?

•	 What went well?

•	 What didn’t?

•	 What can be better  
next time?

Distribution/ 
Implementation

Finish

Evaluation

Celebrate!
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4 Project Planning: Further Explained
Budget
Once you’ve defined your printing need, you’ll need to consider 
your budget. Some methods of communicating your message 
to your audience are less expensive than others. If you need help 
gathering price quotes, please reach out to the Print Center.

Audience
Most campus marketing campaigns, large or small, have up 
to three target audiences: students, staff/faculty, and the 
community. Depending on which audience (or combination of 
audiences), your marketing efforts and approach may differ; e.g. 
You may reach more faculty members if you create a ‘Spaces’ 
page and post a link to it in myPCC Announcements, then you 
can create and post flyers.

Approach
Consider which methods of advertising will be the best approach 
for your audience(s). These may include internal advertising, 
around campuses, via social media posts and ads, or various 
advertising avenues around town. To come up with the most 
effective approach for your project, please consult the Print 
Center.

Timeline
As you create your budget, you’ll also want to create a 
timeline of all steps needed to create the final product. This 
timeline should include adequate time for content generation, 
refinement, designing, proofing, printing, finishing, delivery  
(if needed), and posting. 

Most print projects can be completed in one business day, 
though some may be 10+ business days. Please review our 
Printing Timelines on page 23 and plan accordingly. You’ll also 
want to plan your project deadline for posting your project.  
For most events and activities, posting the finished product  
2-3 weeks before the event will make the most impact with  
your audience(s). 

Details
List the most important details such as event date, time, location, 
URL, cost, etc. You’ll also need to come up with an attention-
grabbing and relatively short call-to-action statement. Keep in 
mind, for most projects, less content is more effective.  
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5By cutting out all of the less-important text and focusing on the 
call-to-action and necessary details, your messaging will stand 
out and make more of an impact on your audience.

Design
Generate ideas for the overall look and feel of the project, 
keeping in mind how this project will fit in with your existing 
projects and communications. If you need assistance, the  
Print Center is home to a talented team of designers for hire. 

Start your project today by filling out the Creative Brief Design 
Request form: pcc.edu/print-center/services/design. This will 
give the designers the information needed to help determine the 
best opportunities for you. 

If you’d rather handle the design work on your own, this booklet 
offers some valuable tips on designing for print. You can also 
visit our resources page on our website: pcc.edu/print-center/
resources. 

If you are intending to use official PCC identity assets, please 
review the brand standards as set by Marketing/Communications 
on their website: pcc.edu/marketing-communications.

Availability
Determine how much time your can dedicate to this project at 
each stage of the timeline. Each project is different, but the Print 
Center design team can help with all aspects of strategizing, 
illustrating, designing, and coordinating the project completion. 
A list of design-related tasks and pricing is listed on pages 8-9  
of the Print Center Handbook.





DESIGN

AWESOME-SAURUS
VER 1.0

DRAWN & RESEARCHED BY: 
THE PRINT CENTER GNOMES

COUNTER-WEIGHT TO 
BALANCE HEAD

HOLLOW BODY

DOOR ENTRY

2’

6 IN

9”

4.5”

1”

9.5”

4”

1” ROUND LIGHT

OR LED INSET

3.5” ROUND JOINT

BALL JOINT

CHARIOT

WHEELS

**Note: the PCC Print Center is unable to print blueprints due to space/costs.**
We would be happy to direct you to one of the local specialty shops.
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7Creating Your Print Project
Recommended Programs, Skill Level & Project Capabilities

Beginner-Intermediate: 
Microsoft Word: Page layout for common paper sizes 
Excel: Spreadsheets, charts, & forms 
Publisher: Almost anything. Comes with downloadable templates 
PowerPoint: Digital content or presentation notes 
Google Docs, Sheets, Slides: Same as the above Office equivalents

Intermediate-Advanced: 
Adobe InDesign: Layouts for any size. Works best with other  
Adobe Suite programs 
Illustrator: Creating vector art/illustrations, artistic text edits 
Photoshop: Photo editing and digital painting

Common Project Sizes 1

Design Layout:
Margins = at least 0.25”; Bleeds = 0.125” on all sides 
Gutters/spacing between content = similar in width to the margins

Color Mode:	 CMYK 2

Asset Resolution:	 All images and logos used should either 
	 be vector files or have a resolution of 300dpi.

File Resolution:	 Print-ready files should either be vector files  
	 or have a resolution of 300dpi.

Preferred File Type:	 .pdf (Press Quality)	  
Also accepted 3 .eps, .svg, .png, .jpg, .gif, .doc, .xls, .ppt, .indd, .ai, and .psd

Paper:	
See Paper Options on page 10 or on pcc.edu/print-center

Finishing:	
See Finishing on page 12

1. All Sizes can be custom, but may accrue additional costs.

2. Some Microsoft and online programs may not allow for CMYK color mode. 
Meaning that projects could print in varying color shades from what you may 
be expecting.

3. PDF files retain most format settings. Other file types may be affected by 
several computer factors that could disturb your formatted content and cause 
unwanted content shifting. Additional steps may be required before submitting 
these files.

Bookmark 
2x6” 

2.75x8.5”

Handbill/Postcard  
4x6”, 4.25x5.5” 
5x7”,5.5x8.5”

Flyer  
8.5x11”, 8.5x14” 
11x17”, 12x18”

Poster Design  
18x24”, 22x28” 
24x36”, 36x60”
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8 Design Software 
Consider the design software for your project, skill level, and 
time availability. If the size of your artwork is limited by the 
design software you’re using, consider using a program better 
suited for the project or hiring the Print Center design team.

Size
You should always create your document at the final size it will 
be in the end. If you only have time to design one file that will be 
printed at multiple sizes, it should be designed at the largest size. 
Keep in mind that files won’t necessarily scale to traditional page 
sizes. For instance, an 11x17” design actual scales down to 7x11” 
flyer and will have large blocks of white space on the left and 
right sides if printed at 8.5x11. Choose the right document size 
to start with for your scalable project by reviewing the Scalable 
Sizes table on page 14.

Design Layout 
For any design that will include colors, text, or images that print 
all the way to the edge(s), be sure to include bleed area outside 
of your main page or artboard. This extra content in the bleed 
area will be trimmed off. Most printers cannot actually print to 
the edges of the paper and must be trimmed after printing to 
give the illusion of being borderless. 
Be sure to build the margins at least 0.25” for documents that 
are 8.5x11” or smaller, and larger margins the larger your final 
document size is. Keep in mind that more space helps the 
readability of your project, wider margins and gutters around 
content will visually help your audience. 

Color Mode
For successful printed projects, your file and all design assets 
should be in CMYK color mode. All of the printers in the Print 
Center, as well as the printers our vendors use, print CMYK.  
If your file is sent to the Print Center in RGB mode, the colors 
may not match how they appear on screen. Please note, each 
monitor is color calibrated differently. Even in CMYK mode, your 
colors may be different once printed. You can request a proof to 
check your colors if needed.

Asset Resolution
Any images used in your project should be saved at 300 dpi 
prior to being added to your design. This will ensure the best 
print quality in the finished project. This doesn’t mean you can 
just change a 2x2” 300 dpi image to an 4x4” image. Doing this 
will actually cut your resolution in half to 150 dpi and will result 
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9in pixelation when printed. Avoid pixelation by choosing larger, 
high-resolution files or by using vector graphics, which can scale 
to any size without pixelation. Vector files are typically, .pdf, .eps, 
.ai, or .svg files. Also note, most images and other design assets 
found online will only be 72dpi (unless otherwise stated). Which 
means they will reduce size by over 4 times once converted  
to 300dpi. Please remember: copyright laws apply when using 
content that you have not created. The owners of the file(s)/
assets must always be credited unless the content originates 
from a confirmed free source. 

File Resolution
The correct resolution for print is 300 dpi, though printing files 
as low as 144 dpi is possible. Some design programs, such as 
the Microsoft Office Suite and online programs, do not offer 
the option to set the resolution. If no other design programs are 
available to you, you can get around this by building your project 
at a larger size, then letting us scale it down proportionately 
when printing. e.g. Microsoft PowerPoint only exports files at 
72dpi, so to get the passable end result of an 18x24” poster, set 
up your file at 36x48”.

File Export
Whenever printing, .pdf files are usually the best file type to 
export and send in as they usually maintain the layout, fonts, and 
images from one computer to another. You can also provide 
other files types, such as the editable file you made. If you send 
us a format other than .pdf, we highly recommend you check  
a proof for expected results before printing starts.

Paper
The majority of our paper options contain 30% recycled content 
or more. Standard paper sizes are: 8.5x11”, 8.5x14”, 9x12”, 11x17”, 
and 12x18”, not all colors or weights are available for each size. 
Posters will be printed on white, uncoated poster paper (similar 
in weight to light cardstock) unless otherwise specified. We do 
not print with white ink, so if you print on a colored sheet, the 
white areas will be the color of the paper. 
If you’re looking for another paper color, weight, or size for you 
project, please email printcen@pcc.edu with your request.

Finishing Options
Deciding how and where your project will be displayed will help 
determine the finishing options needed. For instance, posters 
that will be displayed outdoors should be laminated, and banners 
that will hang on a wall will need grommets.
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10 Paper Stock and Sizes
At the PCC Print Center we have made a commitment to carry 
only environmentally conscious paper stocks. Meaning they 
either contain recycled content, or are FSC or Clean Energy 
Certified. Paper stocks vary from print shop to print shop, and 
while we do try to carry as many different stocks as possible, we 
are limited to what we are able to store in our singular location. 

We can special order a specific stock from our vendor if 
requested, but it will take additional time for ordering and  
we are limited to what can be run through our laser copiers. 

You can view our paper stock at the Print Center at Sylvania 
CC116, request samples through our online order form, or view 
our paper chart at pcc.edu/print-center.

The Print Center follows ANSI standards and carries American 
Standard paper sizes.

Our prescored cards follow envelope rules for A2 and A6 
envelopes, this is different from A2 and A6 paper. 

12x18 Arch B

11x17 Ledger/Tabloid

9x12 Arch A

8.5x11 Letter

8.5x14 Legal

6
.2

5
x9

.2
5

 A
6

 P
re

sc
o

re
d

 C
ar

d
s

5.
5

x8
.5

 A
2

 P
re

sc
o

re
d

 C
ar

d
s

Prescored 
Cards fold to 
fit into USPS 

approved 
Envelopes

A2: 4.375x5.75”
A6: 4.75x6.5”

For printing larger 
than 12x18 we 
are able to print 
posters/banners up 
to 36x120” in house 
on our large format 
printer. For this, 
we have medium 
weight matte paper. 

For vinyl and other 
specialty printing  
we can special 
order for you.

To learn more about 
paper sizing visit: 
www.papersizes.org
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If a bleed is desired, extend the 
image .125” past the edge of paper

Pre-determined edge of paper.
We will cut to this size.

Content should be inside a set .25-.5” 
margin from the desired edge of paper.

Page Layout: Margins
Once you have selected a page size you can now setup your 
page margins. Printed content should be set .25-.50” from the 
outer edge of a sheet of paper- unless cut off text and images 
are the desired look for your project.

Bleeds require more printed real estate. An additional .125” 
extension outside the desired size should be added. Color or 
content meant to “bleed” should extend to this outside border. 
For instance, an 8.5x11” sheet with a bleed should be setup  
at 8.75x11.25”. 

Please review “Saving Files for Print” on pages 16-19 to setup 
crop marks for bleeds.
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12 Finishing: Folding
The Print Center is capable of folding the following types of folds 
in-house. If you require a specialty fold not mentioned here,  
we can have it done by one of our vendors. 

Half Fold Tri-fold
Letter Fold

Brochure Fold

Z-Fold Double Parallel

Designing for folds:
If you are designing a project with folds, you will need to setup 
your file in a specific way.

1.	You will need to design at the correct size.

2.	Divide the sheet into the number of panels required.

3.	Verify that each page is the correct directions, panel number, 
and each panel is the correct dimensions.  
To help with this, fold a piece of paper as an example.

4.	Each panel needs to be setup with .25-.5” margins from the 
edge of sheet and folds.

5.	The folds are close, but not exact, be aware that content can 
shift and some content will not align exactly on the fold.

6.	If bleeds are desired content may shift with the printing,  
cuts and folds.

7.	 Color blocks and lines will not align to a fold every time.

8.	Color print may “crack” if it is in an area with a fold. Try to plan 
for unprinted spaces (gutters) where the pages will be folded.
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13Binding
We offer a variety of bindery options for projects. Keep in mind 
that the more complicated a project becomes, the more it could 
cost. We are also restricted to papers that could be run through 
our machines. See Paper Stock and Sizes page 10. 

When setting up a project for binding, it is vitally important that we 
are given a full .5-.75” margin from the binding side of the page.

Note: When creating a PDF for these files do not save in booklet mode.

The Print Center offers the following binding options:

Single Staple  
A single staple in the corner of a packet.

Double Stapling 
Two staples on a designated side of a packet. Similar to the single 
staple, not to be confused with saddle stitch.

Saddle Stitching 
One or more staples in the crease of a set of booklet folded 
pages. Like a magazine.

Coil Binding 
A booklet punched on one side, held together by a spiral. 
Requires cover pages, these can be cover weight and printed or 
could be a combination of clear or black acrylic sheets.  
Like a spiral notebook. 

Perfect Binding/Panther Press 
The inside pages are wrapped in a printed sheet of cover stock. 
They are held together by a line of flexible glue.  
Like a paperback book.

Book Padding 
The pages are held together like the Perfect Bind, but without 
the wrap-around cover. Covers are the same size as the inside 
pages. Pages can be pulled out or apart like a pad or to be kept 
in a binder. This option was created to replace brads.
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14 Scalable Sizes
When setting up your initial file. It is a best practice to start your 
design at the largest size you will be printing and try to select a 
size that converts to the most scalable sizes. For example, start 
with 22x34” which will proportionally scale down to 11x17 and 
5.5x8.5” (half-sheet) easily. 8.5x11” scales to 4.25x5.5” (quarter-
sheet). If you are wanting a wide variety of sizes for your prints 
you may have to design multiple pieces. Tip: be aware of small 
fonts that will be scaled down, they may be unreadable once 
scaled down.

If time allows, please request a printing cost estimate before 
submitting your project at:  
pcc.edu/print-center/ordering/project-estimate

Assets and Copyrights
When the internet makes it easy to find and download so many 
items, it’s easy to forget that not all things are open source or free. 
An image from Google, clip-art in Microsoft Office, and fonts are 
all subject to copyright laws. To avoid conflict and potential legal 
issues it is best practice to do the following:

•	 Use open resources libraries1. There are many free resources 
online.

•	 Always ask permission before you use a photo or art piece or 
before printing art pieces representing a known trademarked/
copywritten character or subject.

•	 Obtain photo releases. If you take a photo of a person or a 
privately owned building for a publicity piece, a waiver and 
permission from the individual(s) or property owner is needed.

•	 Properly credit copywritten or trademarked work. 

•	 Works cited pages. Even a quote can be copywritten,  
please cite all your resources. 

•	 Create your own art whenever possible.

1. Some verified Open Resources websites:
Stock Photos/Textures: usplash.com, freestocktextures.com, eezy.com
Fonts: dafont.com, fontsquirrel.com, fonts.google.com

Initial  

Size 

36x60” 

36x48” 

24x36” 

22x34”

Small 

Poster 

14x24” 

18x24” 

16x24” 

15.5x24”

Large 

Flyer 

10.25x17” 

11x14.75” 

12x18” 

11x17”

Small 

Flyer 

6.75x11” 

8.25x11” 

7.5x11” 

7.25x11”

Large 

Handbill 

5.5x9” 

5.5x7.5” 

5.5x8.25” 

5.5x8.5”

Small 

Handbill 

3.5x6” 

4x5.5” 

4x6” 

3.5x5.5”
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15

Letter to 

Q
uarter sheet

8.5x11 can shrink
proportionally

to quarter sheet 
(4.25x5.5”)

Ledger to 

H
alf sheet

11x17 can shrink 
proportionally
to half sheet 

(8.5x5.5) 

11”

17
”

8.5x11” is not proportional to 11x17

11”

14
.2

5
”

8.5x11 does not scale 
proportionally

to 11x17

3.56”

5.
5

”

11x17 does not scale
proportionally

to 4.25x5.5

5.
5

” 

4.25” 

Scalable Sizes 
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16 Saving Files for Print
Publisher
Publisher is the more versatile program in the Microsoft  
Office Suite. It has many useful tools for the beginning to 
intermediate user.

Changing Color Profile to CMYK

1.	 File > “Export”

2.	 “Save for Commercial Printer”

3.	 Select “PDF file”

4.	 “Pack and Go Wizard” > Follow prompts to save

An Important Note About Publisher
Publisher comes with many templates and can be quite user 
friendly for those with experience with the Microsoft Suite. 
However, Publisher is not always printer friendly. Here are some 
things to be aware of when using Publisher for your designs. 

1.	 Always double check your formatting when saving, 
especially the PDF’s. Publisher has a nasty habit of shifting 
and cutting content because of how it renders the content 
boxes. Always double check that all your text is visible.

2.	 Do not save in booklet format.

3.	 When in doubt, send us the document so we can help you.



D
E

S
IG

N

17Saving PDF with Crops (for projects with bleeds)

1.	 File > “Export”

2.	 “Save for Commercial Printer”

3.	 Select “Commercial Press” box > Select “Custom...”

4.	 Select “Print Options”

5.	 Select check boxes for “Crop Marks” and “Allow Bleeds”

6.	 Select “OK”

7.	 “Pack and Go Wizard” > Follow the prompts to save

Step 3

Step 4

Step 5

Current as of 8/2019
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18 InDesign
InDesign is one of the most powerful layout programs available.
While it can be overwhelming for a beginning user, you might  
be suprised to find how easy it can be once you have the  
basics down. 

Changing Color Profile

InDesign is the primary 
layout program used 
by designers for printed 
projects. As long as the 
correct project type is 
selected at the beginning 
of designing then it will  
be preset to the correct 
color profile.

If you would like to 
verify the setting do the 
following.

1.	 Edit >  
“Color Settings...”

2.	 Verify that  
“North American 
General Purpose”  
is the setting.
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19Saving PDFs with Crops marks

This is the simplest way to setup a 
PDF with bleeds/crops with InDesign. 

1.	 File > “Export...”

2.	 PDF Preset > “Press Quality”

3.	 “Marks and Bleeds”

4.	 Select “Crop Marks”

5.	 If content Bleeds  
 “Use Document Bleed Settings”

6.	 Export

Current as of 8/2019
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20 Combining PDFs
If you have multiple, similar sized, documents that you would like 
to have printed as one packet, it will save you money to have the 
documents combined and saved as one document. There are 
two ways you can combine these to create one document.

Note: You may need Adobe Acrobat installed on your computer for 
these instructions.

PC Instructions:
1.	Convert all your documents to PDF files 

Save them all in one location to make the next step easier.

2.	Open the location where all the needed documents are located

3.	Select all the documents you want combined

4.	“Right Click” on one of the documents

5.	 Select from the dropdown menu, “Combine files in Acrobat...”

6.	Arrange the files in the order you want the pages to be

7.	Save document

Mac Instructions:
1.	Open the PDF in Preview

2.	Choose view > Thumbnails to show thumbnails in the sidebar

3.	Select a page thumbnail to indicate where to insert  
the document

4.	Choose Edit > “Insert” > “Page from File”

5.	Select document you want added, then click Open

6.	To save, choose File > “Export as PDF”

Combining in Adobe Acrobat:
1.	Load the document you want first

2.	Open the tools panel on the right side of the page. 
If tools are  not present press “Shift+F4”

3.	Select “Organize Pages”

4.	Scroll your mouse/cursor over the page you want to insert 
the next document, until you see 3 options

5.	Select the “+” symbol

6.	Select “Insert from File...”

7.	Select the next document

8.	Repeat steps 4-7 as needed...

9.	Save file
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Quick Pre-Print Check
You’ve made it this far, here’s a quick check list to make sure 
everything is ready to submit your project to the Print Center.

1.	The page size is set to the largest size your prints will be.

2.	The page size selected is proportional to the smaller sizes you 
may be printing.

3.	Margins are set at .25-.5” from the edge of the sheet.

4.	If a bleed is desired, the background image/color(s) extend 
.125” beyond the finished page size.

5.	Images and documents are high resolution, at least 300 dpi, 
not upscaled from a smaller dpi, and are in CMYK color mode.

6.	All assets are open source verified, permissions received, cited 
appropriately, and/or your own creations.

7.	Pages are in the correct order to be printed.

8.	A thorough and careful proof reading has been completed.

9.	Document has been saved as a single PDF.

Proofreading Tricks
Spell check may not catch every grammar error or misspelled 
word. Most spelling, grammatical errors, and misused words are 
because of over reliance on a computer spell check. Here are 
some tricks to have a more thorough and successful proofing.

1.	Print the item to proofread. Studies have shown that users are 
more prone to skip items if reviewed on a computer screen.

2.	If the item cannot be printed, enlarge the content to 200%+. 
Even at 100%, it may be difficult to discern certain letters.

3.	Carefully and slowly read the content, out loud. 
Speaking the words may reveal what your eye has missed.

4.	Read sentence by sentence. Some proofers read the 
sentences from bottom to top, this interrupts the logical flow 
and stops your brain from auto-correcting errors.

5.	Use a dictionary and beware overusing the thesaurus.  
Some words may not be appropriate for your message.

6.	Pay special attention to punctuation, person’s names, 
locations, and dates.

7.	Work on something else for a while before proofing.

8.	Have someone else read it. Fresh eyes will see different errors.





PRODUCTION
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23Print Turn-Around Times
Project Printing Completion Times*

Color or Black & White Printing	 1 business day

Orders of large quantities/assembly required	 3-5 business days

Poster Printing (larger than 12x18)	 3-5 business days

Vinyl Banners, Lettering, and Decals	 7-10 business days

Review a printed proof	 1-3 business days

Business Cards and Name Tags	 10 business days

Panther Press Book Binding/Perfect Binding	 2-4 business days

Coil Binding	 2-3 business days

Pad Binding	 2-3 business days

Cutting or Trimming	 1-3 business days

Folding 1	 1-3 business days 

Perforating	 2-3 business days

Laminating (24” wide or less)	 2-4 business days

Laminating (wider than 24”)	 6-10 business days

Mounting to foam core	 6-10 business days

NCR printing (carbonless forms)	 2-3 business days

Padding	 2-3 business days

Scanning	 1-3 business days

Design Assistance	 Varies, call for availability

*. Project times are set to allow us time to process, print, finish, or send out  
for completion with one of our vendors. Projects placed with less than the  
turn-around time listed may be subject to a $5 rush fee.

1. Up to 10 days if hand folding or specialized folding is requested.
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24 Placing Your Print Order
The easiest way to place your order with the Print Center is 
by visiting: pcc.edu/print-center/ordering/order-printing and 
submitting an order using our online Project Order Form.  
On this form, you can upload your file, add instructions, and 
even request your file be saved for future printing and edits.  
If your file size is too large, you can email it separately after  
filling out the online order form. Please mention in the  
‘Additional Instructions and Notes’ section that you will send  
the file via email. 

Note: there will be a charge if the Print Center needs to combine the 
files for you. For instructions on how to combine PDFs please refer  
to page 20.

Our form only allows one file upload per project order. If you 
have multiple files with the same printing needs, to be combined 
into one finished project, you can add these files to a Google 
Drive folder and share the folder with printcen@pcc.edu. If you 
have multiple different files with different print needs, you will 
need to submit a separate order form for each item.1

If you prefer filling out a paper order form, you can stop by the 
main Print Center at Sylvania campus, CC 116, during business 
hours, or any of our Print Center pick-up rooms at the other 
campuses and centers. Paper order forms are available at each 
and can be added to the ‘Outgoing Order’ tray when filled out. 
Please attach the originals to be copied/laminated or the USB 
of files to the order form, preferably with a paperclip rather 
than staples. Completed order forms will typically be picked up 
the next business morning by our delivery driver. If you project 
is of some urgency, please call the Print Center after adding 
your order to the basket to make sure our driver stops by your 
campus or center. 

Note: Physical orders may not be able to be completed on short notice, 
unless they are delivered direct to the Print Center. To ensure your 
order is completed when you need it, submit an Online Project Form 
and contact the Print Center by phone 971.722.4670.

1. We request for separate orders to avoid additional data charges for you and to 
avoid potential mistakes or missing parts.
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25Delivery Process and Locations
Faculty and Staff: Sylvania orders will be placed on designated 
shelves within the Print Center at Sylvania campus CC 116, 
anyone from your department will be able to access these items. 
If you would like to ensure that only you can pick up your 
finished project, you must select ‘Sylvania - Will Call’ on the 
order form when placing your order. You, a trusted colleague,  
or your admin can pick the projects up during the normal 
business hours of 7 a.m. – 4 p.m Monday - Friday. If your order  
is for a different campus, items will be delivered to the 
designated pickup rooms.

Student/Personal/Outside Customers: Payments must be 
submitted before your order can be picked up or delivered to 
another campus or center.1 Arrange payment by stopping by  
the Print Center or calling 971.722.4670.

Note: Protect yourself by never entering your G# or credit card 
information into our order forms or any unsecured form.

Finished projects are delivered weekday mornings (except PCC-
observed holidays and closures) to the listed campuses and 
centers. Arrival times are estimates and may be affected  
by traffic, weather, or order load.

Campus or Center	 Building and Room	 Delivery Time

Sylvania/Will-Call	 CC 116	 8:30am

Cascade	 CH 108/Mailroom	 9:05am

Southeast	 Tabor 121	 9:35am

CLIMB Center2	 CP 112	 10:05am

Rock Creek	 Bldg 3, Rm 116	 10:30am

PMWTC/Metro 2	 Bldg 1	

Swan Island Trade Ctr	 Reception Desk

Newberg Center 3

Downtown Center2

Willow Creek Center2

1. Due to security restrictions, students and outside customers must arrange  
with a faculty or staff member to be able to pickup at one of the locations 
outside Sylvania.

2. By request only: arrange delivery by calling  971.722.4670

3. Newberg Center orders will be delivered to RC unless otherwise arranged. 
Innercampus mail to this Center can take up to 5 business days for delivery.
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26 Frequently Asked Questions:

Q:	 Can anyone use the Print Center services?

A:	 Anyone can use the Print Center. We will accept 
most projects, and it does not matter if you are 
a student, staff, faculty, or if you are printing 
something for Grandma.

Q:	 Can I use my student account for payment?

A:	 Unfortunately, not at this time. We may be able to 
use the Go-Print service eventually.

Q:	 How can I pay for my projects? Is there  
a minimum?

A:	 We accept cash and Visa/MasterCard. Our minimum 
charge is $1. We do highly recommend utilizing the 
labs on campus as much as possible for smaller 
quantities of print.

Q:	 Do you have a computer I can use to access my 
email or work on my project?

A:	 We do not. However, if your file is a pdf, you can 
print from a USB, or you can email us the project  
to print.

Q:	 The online form is asking for an account/FOAP, 
what do I put there?

A:	 If a department is paying for the print order, type 
in the department account code. For this number, 
ask your department administrative assistant or 
supervisor. If it’s a personal/student order, type in 
the word “Personal”.
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27Q:	 How much time should I give the Print Center to 
produce my project?

A:	 We always ask for at least 24 hours to run an order. 
Some projects may require more time though. You 
can see what our turn-around times are on page 23 
the Turn-Around section of this booklet. If you have 
a rush order please call us at 971-722-4670,  
to check if we have the capacity to run your order 
on short notice.

Q:	 May I receive a quote for a job?

A:	 Absolutely. You can fill out a quote request on our 
website at:  
www.pcc.edu/print-center/ordering/project-estimate/ 
You can also see our current pricing sheet at  
www.pcc.edu/print-center/services/price-guide/ 
Or you could email us at printcen@pcc.edu or call 
us at 971.722.4670.

Q:	 Some of your services are more expensive than  
I’ve found from online printers, why is this?

A:	 The PCC Print Center is a union print shop that 
uses environmentally friendly/American produced 
materials, and practices sustainable production. 
Many online printers are non-union and are located 
where minimum wage is exponentially lower than 
Oregon State (some states are as low as 7.25/hour), 
may carry papers from questionable sources, and 
may not practice sustainable production, or are 
located outside the country.

 



P
R

O
D

U
C

T
IO

N

28 Print Glossary
#: The pound symbol represents the weight of a paper type. 
(Example: 20# bond text weight paper.)

Account #/FOAP: Stands for Fund, Organization, Account, 
Program. A department code used to pay for prints.  

ANSI: American National Standards Institute.

Assets: Any images, fonts, and content used in graphic projects.

Binding: Affixing sheets together as one unit, like a book.

Bleed: Design assets that are printed past the edge of the print 
area. ‘Full-bleed’ is obtained by printing a document with bleeds 
on a larger sheet of paper, then trimming it to the printed area 
size. For instance a full-bleed 11x17” poster would be printed on 
12x18” paper, then trimmed to 11x17”.

Bond Paper: Standard, lightweight printer paper for black and  
white printing. 

Book Padding: The pages are held together like the Perfect Bind, 
but without the wrap-around cover. Covers are the same size as 
the inside pages. Pages can be pulled out or apart like a pad.

Carbonless/NCR Forms: Multiple sheet form. Comes in 2-part 
(white/ yellow) or 3-part (white/yellow/pink). 

Cardstock: Paper with a noticeable thickness, like a bookmark or 
postcard. Also referred to as ‘cover stock’.

CMYK Color Mode: Using cyan, magenta, yellow, and key (black) 
combinations to create process colors for printing. 

Coil: A plastic spiral that binds a group of pages.

Collated: Document is printed in sequential order, in complete 
sets. This is the default for all printed documents. 

Color Copy Paper: High quality, bond paper used for color 
copies. 

Crop Marks: Printed marks to indicate where a project needs to 
be cut or trimmed. Used for bleeds or multiple-up projects.

Double-sided: Document will be printed on both sides of a sheet 
of paper. Also referred to as “back-to-back” or “front-to-back” 
on our order form.

Drilling: Making a hole or multiple holes in a sheet of paper, such 
as 3-holes in paper that will be stored in binders. 

Finishing: Any steps needed to complete a project after printing, 
including folding, trimming, stapling, binding, etc. 
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29Folding: Bending and creasing paper into a neat, predetermined 
size, like a brochure or event program. Common types of folding 
include letter/tri-fold, half/bi-fold, and double-parallel fold. 

Handwork: Any finishing work that can’t be completed by a 
machine, such as non-standard folding, scoring, non-standard 
trimming, course packet assembly, custom stapling, etc.

Index: A lightweight cardstock, typically used for bookmarks, 
small posters, heavier weight handbills, and booklet/packet 
covers. 

Ink Type: Color copy machines print with both color and black 
ink. Black ink copy machines only print in black & white. If a print 
has any color that is requested, it will be printed on our color 
machine.

Laminating: Encasing a sheet of paper in plastic, fused together 
to create a durable finish. Laminant can be trimmed to edge of 
sheet or have a small border for durability. Our lamination is 26” 
wide and billed by the linear foot.

Margins: The spacing inside the edges of a document. For print 
projects, the Print Center recommends at least 0.25” margins to 
avoid any content being cut off during printing or finishing. 

Mounting: Affixing a sheet of paper to a hard backing, such as 
foam core.

Multiple-up: Placing two or more pages on one sheet before 
printing. Also referred to as ‘2-up’, ‘3-up’, ‘4-up’, etc. based on 
the number of pages per sheet.

Originals: The number of printed sides in a document;  
i.e. A postcard with text on the front and back would have  
two originals.

Padding: Gluing one side of a stack of papers to create a pull-
sheet effect, like a notepad. 

Paper Grain: The direction the paper pulp runs in a sheet of 
paper, which affects the way the paper curls and folds. Most 
important when folding cardstock.

Paper Size: The Print Center carries American Standard Paper 
sizes: Letter (8.5x11”), Legal (8.5x14”), Ledger (11x17), and 
Architectural Paper size: Arch B (12x18”). Posters can be printed 
up to 36x120” in-house, or larger through one of our vendors. 

Paper Weight: The thickness of a sheet of paper or cardstock. 
Also referred to as ‘paper stock’ or ‘paper type.’ 



P
R

O
D

U
C

T
IO

N

30 Perforating: Creating a line of small holes for the purpose of 
tearing-off a part of a sheet of paper. 

Perfect Binding/PantherPress: Affixing a group of pages with 
glue and wrapping it with a heavy cover. Like a paperback book.

Poster: Any document larger than 12x18” that needs to be 
printed on a large format printer. Also referred to as ‘oversize 
prints’ or ‘large format prints.’ 

Resolution: The ability of an input device (camera/computer) to 
record, or an output device (printer/monitor) to reproduce the 
fine detail of an image. Recommended minimum resolution for 
print is 300dpi, digital/screen content is 72 dpi.

RGB Color Mode: Using red, green, and blue light combinations 
to create colors on displays such as computer monitors, TVs, and 
digital signage. [See CMYK Color Mode for printing]

Saddle-Stitching: Folding a group of pages in half and stapling 
on the fold to create a booklet or program. 

Scoring: Pressing a line into paper or cardstock to create a neat 
fold that doesn’t crack.

Split-Billing: Payment for an order is split between multiple 
departments or people. Note: The charge for split-billing is an 
additional $5 fee.

Trimming: Cutting a printed document to a desired size. Also 
referred to as ‘cutting’; e.g. to save paper, bookmarks will be 
printed five per 8.5x11” page, then trimmed to their final 2x6” 
size. Any size request outside of one of our standard paper sizes 
will need trimming.

Un-Collated: Each page of a document is printed as a separate 
stack.  
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31Colophon
This booklet was written and illustrated by Angela Hooper  
& was printed and assembled at the PCC Print Center  
by proud AFT Union members.

Printed on the Xerox- Versant Color Digital Press.

Perfect Binding with PCC Panther Press  
(using the Bourg Book Binding System)

Paper Used:
Cover:	 Mohawk Everyday Digital - Smooth - 80# 

10% Post-Consumer Recycled Content, FSC, Clean 
Water, & Clean Energy Certified. 
Produced in the USA.

Section 1:	 Neenah Astrobright - Lunar Blue - 60# 
30% Recycled Content, FSC, Green Seal Certified,  
& EPA transport partner. 
Produced in the USA.

Section 2:	 Neenah Astrobright - Terra Green - 60# 
FSC, Green Seal Certified, & EPA transport partners. 
Produced in the USA.

Section 3:	 Neenah Astrobright - Cosmic Orange - 60# 
FSC, Green Seal Certified, & EPA transport partners. 
Produced in the USA.

Text pages:	Mohawk ColorCopy - 28# 
100% Recycled Content, FSC, Clean Water,  
& Clean Energy Certified. 
Produced in the USA.
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